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Octet® SPR Analysis Features
This tutorial outlines the operation of Octet® SPR Analysis software, a data analysis software package that has been 
tailored for Octet® SF3 data sets. The program allows rapid processing of binding response curves for kinetics and 
affinity analysis. The intuitive, user-friendly interface guides the user through a series of data transformations that 
produce data sets that are then fitted with standard kinetic or affinity models. A key feature is the ability to rapidly 
perform single or double referencing of the data set in advance of model fitting. 

When using solvents such as Dimethylsulfoxide (DMSO) a simple built in tool enables correction of the excluded vol-
ume effect. 

Kinetic and affinity models in Octet® SPR Analysis software include:

 Simple off rate model for determing the dissociation kinetic rate constant (kd)

 Pseudo-first-order kinetic model (1:1 interaction) for determining the association (ka) and dissociation kinetic 
rate constant (kd)

 Two compartment model (mass transport limitation)

 Bivalent analyte model

 Two-state model

 Gradient injection specific models for diffusion and protein aggregation 

 

In addition to kinetic models, a solid phase steady-state affinity calculator is included for use with steady-state bind-
ing data.

A versatile graphics interface permits viewing of the data in a variety of formats with customizable parameters includ-
ing fonts, colors and scaling. Where desired, data may be easily exported as columns of text for plotting in user-
defined data analysis programs or as publication ready image files that may be pasted into your word processing 
software.

Terminology
SPR instrumentation follows the course of an interaction between a molecule bound to the sensor surface (ligand) 
and a second free, solution-phase molecule (analyte). 

Table 1-1:  Key Terms

Term Description

Ligand The interaction partner attached to the surface of the sensor, 
In screening applications, this may also be referred to as the 
Target.

Analyte The solution-phase interaction partner that is injected over the 
surface-bound ligand.
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Opening Octet® SPR Analysis 3
Opening Octet® SPR Analysis
Octet® SPR Analysis can be opened via a number of routes:

 By clicking on the desktop shortcut

 By clicking on the Analyze button located on the View Page of the Octet® SPR Discovery software (Figure 1-1)

 By clicking the Octet® SPR Analysis shortcut located in the Octet® SPR program group

Figure 1-1: Octet® SPR Analysis Application Screen

A splash screen will appear while the Octet® SPR Analysis application opens.

The Octet® SPR Analysis application consists of a series of tabbed pages, each of which performs a transformation of 
the data set. The objective of Octet® SPR Analysis is to rapidly perform reference curve subtraction and kinetic or 
affinity analyses with minimal data manipulations. In some cases, Octet® SPR Analysis will automatically perform 
these transformations if the Octet® SPR Discovery protocol included the default settings for analysis.

Figure 1-2: Tabs for Response Curves

Response Curve Selection
Specific response curves from experimental data can be viewed by selecting from one of the drop-down boxes seen 
in Figure 1-2: Assay Filter, Analyte Filter, or Target Filter. These filters default to show all data but can quickly isolate 
data of interest for review.

Color coding of the data can be adjusted by changing the selection of the Curve Coloration drop-down box. The 
color codes are predetermined by the software and the available options are: Color by Concentration, Color by 
Assay, Color by Analyte, Color by Target and Black (default).
Octet®  SPR Analysis User Guide



Despiking 4
Data can also be scaled according to analyte molecular weight (MW) by clicking the Correction Factor: MW check 
box. Data files exported to Octet® SPR Analysis through the Octet® SPR Discovery control software will automati-
cally transfer analyte MW, if available. The median MW will be identified and all responses normalized to this MW. 
Therefore, theoretical Rmax calculations can be made using this analyte MW. A similar normalization can be applied 
based on the analyte refractive index (RI) by selecting the Correction Factor: RI check box.

Despiking
Data opened in Octet® SPR Analysis are automatically Despiked, meaning that an algorithm scans the data and 
removes/smooths a window of data around perceived spikes. This setting can be turned off by clicking the Configure 
menu button and unchecking Despike. The Despike settings can be adjusted by clicking Despike options. The Num-
ber Peaks Tested defines the maximum number of spikes that can be identified and corrected in a data set. The Peak 
Window Size adjusts how much data is reviewed to identify and correct a spike. Larger Peak Window Sizes will extract 
larger spikes and lower Window Sizes will extract a more refined spike. The Spike Threshold establishes the minimum 
jump in response that should be considered by the algorithm as a potential spike. Figure 1-3 shows data before (left 
panel) and after (right panel) Despike.

Figure 1-3: Spike (left) and Despike (right) Response Curves
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Data Page Description
The Data tab is the initial user interface for review of absolute, unreferenced SPR data.

If not accessed through Octet® SPR Discovery software, click on the Data tab, click the Open button on the toolbar 
and load the desired data (Figure 2-1). Octet® SF3 data files appear as .spr files. File types used by Octet® SPR Anal-
ysis are .qdtx (raw SPR data export) and .qdt (analyzed data files). A simulated data set for a monovalent interaction is 
used to illustrate model fitting. In this experiment, serial tripling dilutions of protein were analyzed by injecting them 
sequentially over all three sensing channels where flow channel (FC) 1 was coated with target.

.

Figure 2-1: Opening the Data Tab

The data set is shown in the plot window in Figure 2-2.
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Figure 2-2:  Data Set Example

The overlaid binding response curves shown in the plot are response curves for all data channels. In general, the 
three channels are represented; two channels immobilized with a specific ligand or capture molecule for kinetics and 
affinity assessment and an appropriate reference channel. High-quality data requires processing the data with use of 
this reference surface. Many of the artifacts associated with SPR binding data can be removed by proper experimen-
tal design and an appropriate reference surface is critical. In this example the simulated data are identical between 
channels and a true reference channel was not present.

Entering and Correcting Analyte Concentrations and 
Names

Correcting analyte concentrations
A sample table appears on the left-hand side of the plot window with a series of analyte and target information 
(Figure 2-3). Each row represents three curves in the plot window, namely the binding response curves for the inter-
action of the analyte with each of Octet® SF3's three flow channels. The concentrations shown in the sample table 
for each cycle are the analyte concentrations entered for each cycle when recording the data using the Octet® SPR 
Discovery software. 

If the concentration was entered incorrectly in the Octet® SPR Discovery software when preparing the experiment, 
the correct concentration can be typed into the appropriate cell in the table. By checking the Show Individual 
Curves in Table option, the information for target versus cycle can be modified. In most cases this will be constant 
but for certain capture assays the Target may change per cycle.
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Figure 2-3: Sample Table 

The analyte concentrations are automatically entered terms of Molarity (M). Alternative abbreviations include:

 m (10-3 M)

 u (10-6 M)

 n (10-9 M)

 p (10-12 M)

For example, where correcting the analyte concentration these can be typed as either "1u" or 1e-6 for a 1 µM sample. 
This method of entering the concentrations is equivalent to the earlier table but is sometimes more convenient, 
especially when changing a small number of samples. 

Note that the table recognizes either designation and can work with a mixed table containing both concentration 
designations.

Correcting analyte names
If an Analyte name was incorrectly entered, it can be changed using the Reassign feature found by right-clicking on 
an Analyte name. The analyte name can be chosen from the list of pre-existing analyte IDs or if not present in the list 
can be entered manually in the New text box (Figure 2-4).
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Figure 2-4: Reassign Menu

Information from the Analyte table can be copied to the clipboard by right-clicking in the table and clicking Copy 
Table. The table information can then be pasted and/or modified for more intensive sorting or name change trans-
formations. Then the table can be re-pasted by right-clicking the Octet® SPR Analysis Analyte table and clicking 
Paste Table (Figure 2-5).

Figure 2-5:  Copy/Paste the Analyte Table
Octet®  SPR Analysis User Guide



Plot Zoom 10
Plot Zoom 
The plot window scales according to the upper and lower limits of the data set. However, the response for the actual 
binding phase of these curves is often much lower than the range of the y-axis, for example when a high-refractive 
index regeneration is used. It is therefore often helpful to zoom in on the binding region using the zoom function. 
Start by drawing a box around the region of interest by clicking and dragging the left mouse button. Next right-click 
and choose the Zoom In option from the pop-up menu (Figure 2-6).

Figure 2-6: Zoom Function

A magnified view of the selected region appears in the plot window (Figure 2-7).

Figure 2-7:  Zoomed Region
Octet®  SPR Analysis User Guide



Eliminating Poor Data Sets 11
Eliminating Poor Data Sets
A response curve may be removed from the analysis, for example, if it can be clearly identified as an outlier, or is of 
poor quality. 

A response curve is removed by one of three methods: 

 If the cycle number of the injection to be hidden is known, it can be removed by clicking the Hide check box in 
the Data tab sample table. A red highlighted curve on this page indicates a hidden curve which will not appear 
in subsequent graphs. 

 Clicking the Hide icon found at the tool bar in the top left side. This dialog enables sorting of response curves 
in a variety of ways and show/hide are options for any of these data views. 

 Double-clicking the curve to be hidden and then right-clicking in the graph to choose the Exclude line option. 
The associated cell in the sample table will be grayed out and the associated curves for all three channels will 
appear red in the Data page plot and be removed from all subsequent tab pages.

Figure 2-8: Eliminating Data Sets
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Description of the Prepare Tab
The Prepare tab contains all the components for data preparation including double reference subtraction, aligning 
and calibrating. 

The data analysis steps progress from left to right: Zero, Crop, Align, Reference, RI Calibration, and Blanks. The Pre-
pare tab shows three views of the data which change when a particular Prepare step is clicked:

 The before graph on the left shows the view of the data before a particular Prepare step has been applied. 

 The after graph in the middle shows the data after the particular Prepare step has been applied. 

 The final graph on the right shows the data as it will be after all Prepare steps have been applied. Clicking in 
one of the Prepare step boxes will change the focus of the left and middle graphs to the changes associated 
with that step.

Figure 3-1: Prepare Tab

The following sections will expand on the features within each Prepare step.

Zero Step
The Zero step allows the set of response curves to be y-normalized so that a zero baseline is set for all curves in the 
set. The left (green) and right (red) time limit lines are positioned near to the analyte injection phase of the curves. 
Usually a 5-10 second window, as delimited by these vertical time lines and located immediately before the injection 
phase, is appropriate. The left plot (Figure 3-2) shows the positions of the selected vertical time lines. The selected 
times are displayed in the Average from and to boxes in the zero tab. Note that the injection start point defaults to a 
time of zero seconds. When the Zero check box is checked, the transformed plot appears on the middle plot. Note 
that absolute responses (RU) vary in the before graph, this is due to the presence of an immobilized protein on only 
one flow channel and a significant reason for the Zero adjustment of the data. 
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Figure 3-2:  Zero Step

Crop Step
The Crop step allows the elimination of unwanted regions of the response curve before reference curve subtraction 
and model fitting. It is recommended to include at least 30 seconds of baseline data before the injection and dissoci-
ation phase while excluding sensor wash steps or the regeneration phase (if applicable). Place the green time line on 
the baseline at least 30 seconds before the injection phase. Place the red time line just before the regeneration 
phase. Check the Crop check box. The selected data set between these limits is then shown in the right hand plot 
Octet®  SPR Analysis User Guide



Crop Step 15
window. The data set now consists of only the regions required for model fitting, i.e. ka (association) and kd (dissocia-
tion).

Figure 3-3: Crop Step
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An incorrectly cropped data set is shown below (Figure 3-4) where a section of the association phase has been 
cropped out. This will interfere with model fitting and must be corrected by adjusting the start time (green line) 
before the start of injection. This is a common error when analyzing OneStep® data where the beginning of the injec-
tion is important for the concentration vs. time profile.

Figure 3-4: Uncorrected Cropped Data Set

Align Step
Octet® SF3's computer-controlled fluidic design ensures that the timing of injections from one cycle to the next is 
highly reproducible. In addition, injections are time-stamped, allowing automatic alignment of injection start times 
when exporting to Octet® SPR Analysis. In cases where large refractive index offsets are present in the injected sam-
ples, it may be necessary to correct for channel time-of-arrival differences using the channel-to-channel Align step. 
The Octet® SPR Discovery software is able to automatically estimate this correction for certain assay types. Each 
channel may be adjusted independently forward or backward in time (preferably leaving one channel at 0). See 
Figure 3-5 for an example. 

It is recommended to observe the bulk refractive index response of a non-binding molecule such as DMSO when 
adjusting channel-to-channel alignment in order to achieve proper referencing.

Figure 3-5: Setting Align Step Parameters
Octet®  SPR Analysis User Guide



Reference Step 17
It is possible to have each injection of a manual injection curve broken into its own cycle for purposes of analysis. 
Begin by loading the data file into the View tab of the Octet® SPR Discovery Software. After clicking Analyze in the 
Octet® SPR Discovery Software, check the box Break into one cycle per injection (see Figure 3-6). This feature is 
built into the  Octet® SPR Discovery software if all injections were performed in the same response graph. Refer to 
the Octet® SPR Discovery User Guide for further instructions.

Figure 3-6: Export Option: Break Into One Cycle Per Injection

Reference Step
Use the Reference step to subtract the interaction of analyte with the reference sensing surface from the response. 
In the Reference Step, channel 2 contains the reference curves. After using the References Step, the corrected data 
set in displayed in the right hand plot. This transformation has eliminated the small response steps due to bulk refrac-
tive index offsets at the beginning and end of each injection. Any non-specific binding or baseline drift due to other 
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RI Calibration Step 18
interferences are also subtracted, making this a powerful means of isolating the responses due to analyte binding in 
the presence of artifacts.

Figure 3-7:  Reference Step

RI Calibration Step
The process outlined below can be simplified by using the Assay Micro-calibration feature. More information can be 
found on this technique in the Octet® SPR Discovery User Guide.

Dimethylsulfoxide (DMSO) is a common solvent included in SPR assays with small molecule analytes. However, 
DMSO possesses a high refractive index and even low concentrations (<1%) give rise to bulk refractive index 
responses that dwarf the actual binding signal of small molecules. Consequently, it is necessary to add DMSO to the 
running buffer before running the experiment in order to reduce this bulk refractive index offset. Despite best efforts, 
a difference in sample and assay buffer refractive indices can exist and require solvent calibration to resolve low ana-
lyte binding signals. The DMSO page uses micro-calibration injections of DMSO that can be included in assay proto-
cols to construct a calibration curve that is then used to correct the final data set in advance of curve fitting. 

To construct a solvent calibration plot you must prepare at least three solvent standards (and preferably six) that 
encompass the potential solvent concentration range of the sample buffer. For example, if an analyte 
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was injected across an immobilized ligand in a running buffer (PBS-T) containing 3% DMSO then a suitable six-point 
DMSO calibration curve might contain the standards 2.5, 2.7, 2.9, 3.2, 3.4, and 3.7 % DMSO in PBS-T. These DMSO 
standards are then injected similarly to standard analyte samples in the same assay and their values then used to 
construct a calibration plot using the following procedure.

Figure 3-8: RI Calibration Step

Next, the concentrations of the DMSO standard samples are set to the value ‘d’ to designate them as solvent stan-
dards (see “Correcting analyte concentrations” on page 7 for further information on reassigning and correcting con-
centration values). Next, the time limit lines are set in the RI Calibration step to construct the DMSO calibration plot.  
The before graph in the Prepare tab displays the time limit adjustment. The green and red lines are centered over a 
time point during the sample injection and the blue line is set directly on the injection stop.

Figure 3-9: Time Limit Adjustment

When the time limit lines are set properly, the Configure button can be pressed and a calibration plot is constructed 
when either Linear or Quadratic is selected in the pop-up window. The effect of varying solvent concentration is 
quantified and subtracted out of the sample signal. It is important to ensure that the samples lie within the solvent 
concentration range chosen, thus making this calibration appropriate. 

Blanks Step
The composition of the running and sample buffer can have a large effect in SPR assays due to the presence of 
excipients. These can lead to an apparent change in the observed response even when injecting sample buffer in the 
absence of analyte (blank buffer injection). In order to generate the best quality data, it is important to double refer-
ence subtract that assay data. The preliminary reference subtraction is performed as shown in “Reference Step” on 
page 17 but to account for buffer effects the blank injection response must be subtracted from the entire data set.

The kinetic model fit will be inaccurate if this blank buffer injection response is ignored.

The random noise of a corrected curve is the sum of the noise from both working and reference curves: Therefore, a 
double-referenced response curve will possess more random noise than a single-referenced response curve. 
Note that Octet® SPR Analysis automatically assumes that all samples with concentration equal to zero in the sam-
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ple table are blank buffer injections. It is recommended to run at least three replicates of this blank and to choose the 
Average option in the Blank page (Figure 3-10). This will produce an averaged curve that is then subtracted from the 
full data set. Alternatively, selecting the Closest option will use only the curve that is nearest to the data set. Closest is 
more commonly used in large data sets run over many hours and where the buffer blank is repeated periodically.

Figure 3-10: Blank Step 

Outlier buffer blank injections can be removed from the data set by double-clicking the outlier in the left graph and 
then clicking the Remove button.   
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Description of the Point Studies Tab
The Point Studies tab page enables rapid plotting of analyte dose response curves or other point-variable relation-
ships. This tab contains a Point Selector which is optionally minimized at the top left side of the page.  

A drop-down box allows different plots and analyses to be generated.

Affinity Plot
In an SPR assay, the analyte binding response should be proportional to the concentration of the analyte and there-
fore, dose response plots are a good test for outlier responses. In the absence of outliers, the user should expect a 
dose response curve similar to Figure 4-1. The dose response curve is obtained by positioning the Req line (blue line 
in the Point Selector graph) on the response curve just before the end of the sample injection phase. The mean 
response of the Window size data region is calculated for each curve and plotted as a function of the analyte concen-
tration. Readjustment of the position of the Req lines will result in an immediate adjustment in the dose response 
curve.

Figure 4-1: Affinity Plot

Affinity plot: OneStep®

In addition to standard multi-cycle kinetics, plots can also be prepared for an analyte dose response curve for One-
Step® injections. The number of Req points can be adjusted with the up and down arrows. Figure 4-2 shows such a 
plot generated from multiple OneStep® injections of Trastuzumab binding erbB-2 (Her-2/neu).
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Figure 4-2: OneStep® Plot

NOTE: It is important to remember that equilibrium analysis of SPR data requires that each dose reach steady state, 
or an inaccurate affinity measurement will be made. More discussion on the specifics of model fitting in this page are 
shown in the following sections.
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Affinity plot: formatting
All graph properties can be adjusted as desired. Right-click the graph and select Properties from the pop-up menu 
and alter parameters as required (Figure 4-3).

Figure 4-3: Formatting the Affinity Plot

Affinity plot: model fitting
As noted above, use of the Affinity model when analyzing dose responses necessitates all analyte concentrations 
have reached steady state. Note that dose responses are divided by flow channel with a new row of tabs, whereas the 
Point Selector graph will show all available flow channel responses. Checking the Fit check box (top left corner) will 
automatically fit a simple 1:1 steady-state affinity model to the data (Affinity Plot: Fit Check Box). The Fit check box to 
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the right of the Rmax parameter box designates Rmax as a fitted parameter in the model. Alternatively, if left 
unchecked, the Rmax value can be entered as a fixed value.
  

Figure 4-4: Affinity Plot: Fit Check Box
Octet®  SPR Analysis User Guide



Affinity Plot 26
When multiple analytes are fit with the Affinity model, the Analyte MW will often require local Rmax values per Ana-
lyte. To enable a locally fitted Rmax for each analyte, click the L column heading in the Affinity table (Figure 4-5). The 
L column indicates the analyte Rmax is fit locally if checked, and the F column indicates the analyte Rmax is fitted 
rather than manually entered.
 

Figure 4-5:  Affinity Plot: Locally Fitted Rmax

The prior examples show much better fits when local Rmax is allowed, because analyte MW varies by ~2-fold. The 
Show as % max allows the Y-axis of the affinity plot to be displayed as a response relative to the Rmax (Figure 4-6).
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Figure 4-6:  Affinity Plot: Local Rmax

If a local Rmax is not desirable the data can be MW Corrected as outlined in “Entering and Correcting Analyte Con-
centrations and Names” on page 7 and the data can be fit with a global Rmax (Figure 4-7).

Figure 4-7: Affinity Plot: Global Rmax 
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After the affinity model fitting, the KD is displayed in the Affinity table with standard error from the model fit. The 
desired representation of standard error can be changed using the Std. Dev. Display option located under the Con-
figure menu.

The Affinity model can also fit a two-site equation assuming the analyte binds to two sites on the immobilized target, 
each characterized by a different binding affinity. To fit a two-site model click the box designated 2 in the sample 
table and a second site is introduced for all analytes. Individual analytes can be checked in this column as well.  

Another data column will appear in the sample table when the check box Calc % Bound is selected. This option 
allows estimation of the percentage of analyte that will be bound for different mole ratios of analyte and ligand from 
the affinity constant returned in the model fit. Two parameter boxes appear to the right of the Calc % Bound check 
box allowing the concentration of drug (analyte) or protein (Target) to be entered. The % Bound displayed in the 
table is calculated for quick reference. See the Appendices for the equations used in the Affinity model(s) and the 
Protein Binding model.  

Hit Selection
The purpose of the Hit selection feature is to enable rapid and accurate identification of fragment hits in the setting 
of a primary screen assay. 

The necessary elements for Hit selection are: injections of fragments at sufficient concentration to elicit response 
(typically 100 - 500 µM), a positive control analyte at a near-saturating concentration injected periodically, a nega-
tive control analyte (optional) injected periodically, at least 96 fragment analytes and preferably 384 or more. The Hit 
selection processes primary SPR screening data by applying a LOESS (LOcal regrESSion)correction to the positive 
control and response data to account for parameters including drift, activity decay, and aberrations.

Using the Point Selector window, drag the blue line for one Req point at the plateau of the injection. Figure 4-8 shows 
an example OneStep® data set.

 

Figure 4-8: Hit Selection
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Similar to the Affinity plot, the active flow channels are separated by tabs in the Hit selection plot. Identify the positive 
and negative controls for the target immobilized on that flow channel using the drop-down boxes. Figure 4-9 shows 
the uncorrected Hit selection plot for an example screen

Figure 4-9: Hit Selection Plot
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The slide bars can be used to adjust the span settings for the control (positive control) and response LOESS correc-
tions, respectively. Ideally, the positive control will be shown with a straight line across 100%. However, it is important 
not to choose the lowest span in order to avoid over-correcting the data. Figure 4-10 shows unacceptable LOESS 
span settings on the example screen.

Figure 4-10: Unacceptable LOESS Span Settings

The Selection Method can be chosen from: Box-Whisker, Norm Exp, or Combined. Box-Whisker is adjusted with the 
Hit Magnitude, Inter Quartile Range (IQR) Scale where a value of 3.0 is considered appropriate for most data sets. 
Lower IQR values will be less stringent when identifying hits and higher values will be more stringent. Norm Exp (nor-
mal exponential) is adjusted with the Hit Percentile Cut-off which defaults to 99.990, an appropriate setting for most 
data sets. Larger percentile cut-offs will be more selective than lower cut-off values. The Combined selection 
method enables both of the methods listed above and acknowledges overlap between hit identification with a "Mul-
tiHit" designation, where Hit designation means selection by a single method as opposed to both methods.

When a Hit selection method has been finalized, the Kinetics tab will show only hits and controls determined by that 
method. In this way the user can focus on kinetic and affinity analysis of the hits from the screen and ignore the non-
binding analytes. In order to show all analytes in Kinetics, simply return the Hit selection drop-down menu to either 
None or Affinity.
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Kinetics Tab Introduction
The objective of the Kinetics tab is to allow kinetic modelling by non-linear regression curve fitting in order to extract 
the kinetic rate constants for the interaction. Figure 5-2 shows a typical kinetic page before curve fitting.

Figure 5-1: Kinetics Page

There are several elements to this page and the screen shot below indicates eight features that will be described.
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Figure 5-2: Example of Kinetic Modeling

1. Response window: The black curves illustrate the binding data to be fitted with the chosen model. The green 
and red time lines represent the injection start and injection end time points, respectively. These must be accu-
rately positioned for successful curve fitting.

2. Model selection: The drop-down box includes an option to avoid fitting any curve (i.e. None). With Sites (#3 in 
Figure 5-2) set to 1, all models assume that the data can be approximated as a pseudo-first-order 1:1 interaction. 
Refer to Appendix D for a detailed discussion of each model. 

Selecting Simple off (i.e. kd) allows only the dissociation rate to be fitted to the dissociation phase of the 
response curves. 

The Simple model (i.e. ka kd) allows both the association rate constant and the dissociation rate constant to be 
determined. 

A two compartment model (i.e. Transport km, ka, kd) is provided for kinetic analysis where partial mass transport 
limitation is suspected. This model assumes the formation of an analyte gradient at the interface between bulk 
and surface thereby compensating for analyte transport limitation. Other special-case binding models are avail-
able and are discussed later. 

The ResSD value is the residual standard deviation of the fitted curves from the actual data curves. 

The Affinity (K) model fits a real-time isotherm to the data assuming all points are at equilibrium. 

NOTE: This is a reasonable assumption when the kd is 0.05 sec-1 or faster.

1, 52 3

4

6

78 9
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3. Sites selection: This drop-down box allows the model to fit for multiple independent binding sites. This should 
be kept at 1 for most data sets. Other effects such as steric hindrance or rebinding may have a better fit with a 2-
site model; however, this of itself does not confirm that two independent binding sites are present. Careful con-
sideration of predicted biological function should be used when determining the number of sites to use with the 
model fit.

4. Fitted parameter table: The table includes the starting parameter values used to generate the simulated curves. 
When the fitting is complete these values will represent the optimized fitted parameters. The curves simulated 
from this initial value produce a set of simulated curves that differ from the actual experimental curves. Further 
fitting will result in simulated curves that differ very little from the actual experimental curves.

5. Simulation graph: Simulated response curves generated using the initial parameter estimates from the table 
and the simple association rate and dissociation rate model (i.e. ka and kd). Prior to fitting, these simulated curves 
(shown in red) are different to the actual experimental data. After fitting is complete the fitted curves should 
superimpose upon the experimental curves.

6. Residuals: Residual plot showing the residual difference between the experimental curves and the simulated 
curves at each time point.

7. Fit Button: The Fit button begins the non-linear regression algorithm resulting in optimization of parameter esti-
mates. The procedure performs successive iterations where the model parameters are changed in a systematic 
way in order to minimize the residuals.

8. Kinetic Options Button: The Options button provides a means of changing the model fitting in a variety of ways 
to suit your data set. See sections “Bivalent Analyte Model” through “Kinetics Options: Other Model Fitting 
Options” for more information on these fitting options.

9. Estimate Button: The Estimate button will provide initial estimates for any fitted parameter and can be clicked 
when a specific cell or cell range is highlighted in the Fitted parameter table. In some cases, the existing parame-
ter value may need to be cleared before a new Estimate can be generated.
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Kinetics: Dissociation Rate Constant
In some cases, the dissociation rate constant is fitted independently, such as when analyte concentration is 
unknown. The program fits the simulated model curves to the dissociation data to determine best-fit kd for each ana-
lyte. To identify the beginning of the dissociation phase drag the red line to the start of the dissociation phase in the 
data set. Click the Fit button to begin the least squares regression.

Figure 5-3: Dissociation Rate Analysis 

Dissociation rate analysis is useful for off-rate ranking/screening and can be used to produce Avidity plots.
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Kinetics: Association/Dissociation Rate Constants
The simple 1:1 model simultaneously fits the rate constants of association and dissociation and estimates binding 
affinity. Drag the green line to the injection start (often 0 sec) and the red line to the injection end. 

TIP: Zoom into the data set around injection start and stop to accurately identify these two time points.

 

Figure 5-4: Kinetics: Association and Dissociation Rate Constants

After clicking the Fit button, the program begins the least squares optimization of the simulated curves. It is very 
important to pay attention to the placement of the vertical time lines that designate the start and end points for the 
association phase of the curve. Figure 5-5 shows the result of the model fitting procedure.
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Figure 5-5:  Curves After Least Squares Optimization

The simulated curves almost completely superimpose on the experimental data as shown by the low residual values, 
indicating a good model fit.

Kinetics: Mass Transport Limited Kinetics
Fitting the Transport (km, ka, kd) model is performed performed similarly where the mass transport rate constant is 
included in the model (Figure 5-6). 

When fitting this model, it is important to note that fitted values for km of 1e8 m*s-1 and greater represent no signifi-
cant mass transport limitation in the majority of interactions. In this case the Simple (ka, kd) should be used. 

If some analytes demonstrate transport limitation while others do not, the transport rate (km) can be fixed at
 1e9 m*s-1 which ensures mass transport is not limiting for the observed kinetic rates. Also, fitted values of km of 
5e5 m*s-1 or slower should be carefully considered as these are irregular values for the Octet® SF3 flow cells.
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Figure 5-6: Kinetics Mass Transport

TIP: Mass transport limited kinetics are often characterized by linear association and slightly biphasic dissociation. 
Non-transport limited kinetics will have more rounded curvature in association and monotonic dissociation curves.

Kinetics: OneStep® Injections
OneStep® data analysis is similar to the analysis of conventional data sets with one main difference. In contrast to fit-
ting conventional binding interaction curves, the concentration of analyte changes continuously during the injection 
and versions of the simple model and the complex models have been adapted accordingly. Figure 5-7 shows a One-
Step® gradient assay in the kinetic tab of Octet® SPR Analysis. Note that the green solid line represents the relative 
analyte gradient concentration versus time.
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Figure 5-7: Kinetics OneStep®

Additional parameters appear on the Kinetics table when fitting OneStep® data. The analyte diffusion coefficient is a 
critical component of the analysis of OneStep® data because it defines the shape of the concentration gradient. 

In addition to the previously discussed parameters there are two new factors shown in the Kinetics table. The Dapp is 
the apparent Diffusion Coefficient and the Nagg is the Aggregation Number. The Dapp defaults to the value deter-
mined from the analyte molecular weight. In this case Nagg will be at 1, indicating the analyte is a monomer of its ideal 
MW. Both of these can be fitted by selecting the Dapp column and floating these values. Then click Fit on the Kinet-
ics Page. As the model fits Dapp to conform to the data it will adjust the Nagg respectively. 

Refer to see “Kinetics Options: OneStep® Injection Options” on page 46 for other specific model fitting consider-
ations.

Kinetics: NeXtStep™ Injections
NeXtStep™, like OneStep®, enables the injection of concentration gradients of analyte(s) which can be fit with stan-
dard kinetic and affinity models. When a NeXtStep™ injection is used for direct analyte binding (not in a Competition 
or Inhibition method), the resulting data can be fit with the Simple (ka, kd), Transport (km, ka, kd), Affinity (KD), or other 
available binding models.   

A key difference of NeXtStep™, compared to OneStep®, when analyzing binding data is that diffusion is not a param-
eter in the model fit since the gradient is not defined by analyte diffusion theory. Rather, analyte dispersion is empiri-
cally observed using a surrogate sample (typically Sucrose) and the gradient is defined by concentration coefficients. 
Methods for analyzing competition or inhibition data using NeXtStep™ will be addressed in specific Technical Notes.
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Affinity Model
A real-time equilibrium isotherm model (Affinity (KD)) can be applied to data with sufficiently fast dissociation rate 
constants (0.5 sec-1 or faster). This model assumes that all points are at steady state and fits for equilibrium dissocia-
tion constant (KD) and Rmax only. Figure 5-8 shows an example of an Affinity isotherm fit with a two-site interaction.

Figure 5-8: Kinetics: affinity model

Bivalent Analyte Model
The Bivalent Analyte Model represents data where the analyte has two (or more) identical binding sites which can 
bind the immobilized Ligand individually or simultaneously. The following is the rate equation describing the Bivalent 
Analyte model:

Figure 5-9: Rate Equation Bivalent Analyte Model 

In the equation, B is Ligand and A is Analyte which can bind two Ligand molecules. The most common example of 
Bivalent Analyte is an IgG antibody molecule analyte binding immobilized antigen. In this example, each antibody 
binding site can bind antigen and after the first site binds antigen (Ligand), the second site is able to bind a neighbor-
ing antigen at a different (due to proximity) rate. Since the Bivalent Analyte model is more complex, it is recom-
mended that the user read Appendix A for guidelines on when to apply a more complex kinetic model but it in 
general it is recommended to design assays so that the simplest model (1:1) can be assessed. 
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Note that ka2 is in terms of RU-1s-1 and requires conversion by refractive index increment to be interpreted as M-1s-1. 
An in-depth review of the Bivalent Analyte model is shown in the work by MA Cooper & DH Williams (1999)1 , where 
SPR was used to compare the kinetics of antibody binding antigen (ligand) and antigen binding antibody (ligand).

Two-State Model
The Two-State Model represents data where the analyte binds ligand forming reversible complex (AB) which can 
proceed to a second state (AB’). The second state may be a different conformation of ligand or complex, covalent 
reaction, etc. The rate equation describing the Two-State model is shown in Figure 5-12.

Figure 5-10: Two-State Model Equation

In the equation, B is Ligand, A is Analyte, AB is the initial bound complex, and AB’ is the bound complex in its second 
state. Since the Two-State model is more complex, it is recommended that the user read Appendix A for guidelines 
on when to apply a more complex kinetic model.

Two-State Irreversible Model
The Two-State Irreversible model is a simplification of the Two-State model, wherein complex that has changed to 
the second state AB' does not readily return to the initial state AB. In the above rate equation, parameter kd2 is a fixed 
constant of 0 sec-1. When this model is selected, an additional term Cc - the commitment to covalency - will be dis-
played in the Kinetics result table. Cc is defined by the following relationship:

Figure 5-11: Two-State Irreversible Model Equation

It is recommended that the user read Application Note 23,  Commitment to covalency: kinetics of irreversible 
inhibitors with a regenerable streptavidin sensor on the Pioneer FE system for a complete set of guidelines on when 
to apply a more complex kinetic model such as the two-state irreversible model.

1. MA Cooper & DH Williams, Kinetic Analysis of Antibody-Antigen Interactions at a Supported Lipid Monolayer. Analytical Biochem. 276
(1999) p. 36-47.
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Diffusion Model
The Diffusion model can be used to fit the apparent diffusion coefficient of an analyte using only the refractive index 
signal when a diffusion-based injection (i.e. OneStep®) is used. This model assumes a linear relationship between 
concentration and SPR response exists (i.e. non-binding refractive index response). Therefore, this model should not 
be used for interactions where kinetic or affinity binding is occurring. For most biomolecules, a concentration of 
>0.1 mg/mL would be necessary to observe a reliable response. Concentrations of >100 mg/mL analyte can be 
tested unless significant viscosity or precipitation is issue. Figure 5-12 shows a OneStep® Pulse injection of a 3% 
sucrose solution fitted to the Diffusion model.

Figure 5-12: Example of a Diffusion Model

The fitted parameters for the Diffusion model are Rmax (RU) and Dapp (m2/s). Rmax represents the signal at maximum 
concentration, which is observed for sigmoidal OneStep® but is not observed for OneStep® Pulse. Since refractive 
index is expected to be linear to analyte concentration, Rmax in this context can be explained as:

Rmax = C*ηd

where C is analyte concentration (typically in mg/mL) and ηd is refractive index increment (RU*mL/mg). Alternative 
units can be used where available. This can be viewed as a QC metric for the sample response which should give an 
Rmax value within the correct range for known concentration and ηd.

Aggregation Model
The Aggregation model  can be used to quantify the relative concentrations and diffusion coefficients of compo-
nents in a bi- or poly-disperse sample using only refractive index signal from a diffusion-based injection (i.e. One-
Step®). The basic assumption with the Aggregation model is that the sample comprises at least two analyte 
components that differ by diffusion coefficient (i.e. monomer and heptamer components, etc.). A requirement for 
the Aggregation model is that the total analyte concentration and the analyte refractive index increment (ηd or dndc) 
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be known. Fitted parameters of the Aggregation model are refractive index increment of monomer (dndcm), diffu-
sion coefficient of monomer (Dm), concentration of aggregate species (Ca), refractive index increment of aggregate 
species (dndca), diffusion coefficient of aggregate species (Da). 

Output parameters from the Aggregation model are concentration of monomer species (Cm) and percent aggre-
gate (%agg). Ideally dndcm and to a lesser extent, dndca, should be known. Dndc for proteins >10 kDa can typically be 
assumed to be 188.8 RU*mL/mg and predictions for a wide panel of proteins have shown a range of 
180 – 200 RU*mL/mg1 . A wider distribution is seen for smaller proteins, but the mean dndc is still similar at 190.2 
RU*mL/mg. Note that the Aggregation model enables a separate Retention term for monomer (RFm) and aggregate 
(RFa). Refer to “Retention” on page 47 for more information.

Kinetics Options: General Options
The Kinetics Options button accesses additional parameters for modelling complex data or data with specific arti-
facts. Kinetics options can be selected by clicking the Opts button as shown in position 8 in Figure 5-2. The top tool 
bar has four buttons;  the Fix button is used to designate parameter values as constant for a model fit. By default, all 
parameters in the Kinetics Options pop-up window are fixed unless they are manually floated. The Float button des-
ignates parameter values as variables that must be iteratively fit.

Figure 5-13: Kinetics Options

Link tab
The Kinetics Options pop-up allows each fitted parameter to be fitted as a local parameter or as a global parameter. 
In Octet® SPR Analysis, this local/global indication is called Link. The parameters of any particular model may be 
constants or variables and may be fitted separately to each curve in the set representing various analyte concentra-
tions (i.e. local fitting) or constrained to the same value for the set of curves (global fitting). Parameters should be 
constrained when this is possible as it results in a more robust fit. However, there are occasions where it is not correct 

1.  H. Zhao, P.H. Brown, P. Schuck. On the Distribution of Protein Refractive Index Increments. Biophys. Journ. 100 (2011) p. 2309-2317.
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to fit all parameters globally. For example, in affinity capture (a common kinetic assay format), the analyte binding 
capacity (i.e. Rmax) is not constant for all interaction curves because there is experimental variability during the ligand 
capture step. This variation in capacity may be dealt with by fitting the Rmax as a local variable. To do this click the Link 
tab in the Kinetics Options. Figure 5-13 shows this window. Each row in the table represents an individual curve. 
During the curve fitting process, the fitting algorithm fits the model parameters to the first curve in the table. If "1" is 
entered in all rows for all other curves, the algorithm assumes that there is only one value for this parameter for the 
data set. Note that 1 corresponds with the injection ID number in the far-left column thus linking all injections to 
injection #1. Figure 5-13 shows all other curve parameters are linked to injection #1 which ensures that the ka, kd and 
Rmax are all fitted as global parameters (i.e. only a single value is allowed for the entire data set). However, if the values 
in the Rmax column are deleted as shown in Figure 5-14, Rmax will be fitted locally (per curve). After adjusting this 
table, press OK and press the Fit button. The different Rmax values for each curve are now shown in the Kinetics page 
parameters table. 

Figure 5-14: Link Table

Similarly, it is also possible to fit ka, kd and km as local parameters but this is not considered best practice and assay 
optimization should be prioritized.

Begin and End Tabs
The Begin and End pages serve the same function as the vertical time lines on the plot. They simply designate the 
start and stop times for the association phase of an interaction curve. Usually a set of interaction curves will possess 
the same start and stop time points and the vertical time lines are a useful way of conveniently setting these for the 
model. This corresponds with the All radio button selection. However, there are non-ideal situations where it may be 
desired to fit a model to a set of data with association phases of different durations. In this case, go to the Begin page 
and select Separate as shown in the  screen shot on the right in Figure 5-15. The actual start time for each association 
phase is typed into the table for each curve. The values appear red indicating that they are constants and will be fit-
ted as such. Highlighting these values and pressing the Float button will designate these values as local parameters 
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to be fitted but this is not recommended. The end time points may be added in a similar fashion in the End page. If 
the injections are set to the same start/stop times (All), the Fit check box allows the model fitting to find the best fit 
for these values as well.

Figure 5-15: Kinetic Options: Begin Tab

Step RI Tab
Most of the data analyzed in this Tutorial does not possess significant bulk index offsets and it is unusual to have such 
signal offsets when reference curve subtraction is employed. However, it is possible to observe bulk index offsets, 
especially when a large differential in mass loading exists between the working and reference flow channels. This can 
result in the excluded volume effect where volume excluded by protein modulates the sensitivity of the optical chan-
nel for changes in refractive index. These appear as steps at the beginning and end of the injection (i.e. association 
phase) and are due to bulk refractive index variations or in some cases bulk refractive index offsets due to an 
excluded volume effect. The simulated curve shown in Figure 5-16 shows a bulk index offset.

Figure 5-16: Curve with Index Offset 
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Octet® SPR Analysis can add steps to the simulated curves to account for these offsets. To use this function, press 
the Options button on the Kinetics tab page tool bar. The pop-up in Figure 5-17 will appear.

The Step Refractive Index (Step RI) page is shown in the following two screen shots. The screen shot on the left 
shows that the bulk refractive index value for each curve is set at zero and is designated a constant. If the data 
includes bulk refractive index offsets, these will need to be fitted locally to each curve during model fitting. To do this, 
simply highlight the column of values and then click the Float button. The values will appear black. Click OK. The 
pop-up will close and the program will return to the Octet® SPR Analysis kinetics page. Select the Fit button. The 
model is then fitted to the data set but the bulk refractive index offsets are included in the fit. After fitting, re-open 
the Kinetic options pop-up and the optimized response steps for each curve are displayed as shown on the right in 
Figure 5-17. 

NOTE: Step RI can be fit to OneStep® injections as well, where the RI shift is applied through the entire association 
phase regardless of gradient profile.

Figure 5-17:  Kinetics Option: Step RI Tables

This function allows accurate model fitting when bulk refractive index offsets exist in the data.

Kinetics Options: OneStep® Injection Options

Analyte RI
Analyte RI refers to a refractive index offset in the data attributed to the inherent refractive index of the analyte. In 
OneStep® injections, the analyte concentration changes versus time, so this RI term adjusts according to the analyte 
concentration profile. This term can also be used in many cases to model refractive index offsets due to buffer sol-
vents such as DMSO. 

NOTE: The Solvent RI term is also available to model solvent RI offsets. 

Care should be taken during sample preparation to minimize refractive index offsets as described in “RI Calibration 
Step” on page 18. This term can be floated to remove these effects from referenced data for conventional and gradi-
ent injection types.
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Solvent Diff & Solvent RI
Solvent Diff and Solvent RI are two corresponding parameters that model solvent RI offsets specifically in OneStep® 
data. Solvent Diff (diffusion coefficient) represents the diffusion coefficient of the solvent offset or discrepancy. This 
is a value which requires manual input and cannot be fit as a floated parameter. A fast diffusion coefficient often 
describes this offset behavior (for example 1e-9 to 5e-9). Solvent RI will not function without a manually input Solvent 
Diff coefficient. However, once Solvent Diff is input, Solvent RI can be fit as a floated parameter. As described in “RI 
Calibration Step” on page 18,  the solvent offsets in a sample should be minimized, if possible, and Solvent RI is 
intended only for those which may remain after calibration.

Retention
Retention in Kinetics Options refers to analyte retention in the capillary tube during a OneStep® injection. The 
retention term can be fitted if there is concern that the analyte is interacting with the tubing as it moves towards the 
flow cell. This will show in the data as a curve that binds later than expected, and so the model will be shifted to the 
right in time. This can be fitted by selecting the Retention values in red and clicking on the Float button at the top. A 
local fit for each analyte can be done by removing the numbers in the Link column; however, this is not as robust as 
the recommended global fit routine.

Figure 5-18:  Kinetics Option: Retention

The retention term is a value between 0 (no analyte retention) and 1 (complete analyte retention). For best results, 
ensure that retention does not exceed 0.3 as this may indicate that a strong hydrophobic event is occurring between 
analyte and tubing. In some cases, retention can be fixed at a value greater than 0.3 but the analysis is not as robust if 
retention is present at such a high level. Often buffer conditions must be modified to prevent analyte adsorption/
sticking to tubing or other surfaces. Figure 5-19 shows a simulation of moderate affinity binding (KD ~600 nM) with 
different retention factors where 0.3 retention factor represents a significantly retained interaction.
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Figure 5-19: Simulated retention data

Kinetics Options: Other Model Fitting Options
The final tab in the Kinetics Options pop-up is the Options tab. The Rate upper limit box specifies the maximum 
allowable ka for a model fit and improves the reliability of the fitting procedure by bounding this parameter. The end 
Chisq (i.e. c2) change defines the cut-off point at which the difference between the simulated and experimental 
curves is considered minimal; the optimization procedure is terminated when this value is reached. The Max number 
of iterations box sets the upper limit on the number of iterations the curve fitting algorithm will run before stopping. 
The Update Display option sets the frequency for updating the fitted graphs. For example, a value of 1 will update the 
fitted graphs after every iteration of the curve fitting algorithm. A larger value will update the graph less frequently 
during curve fitting but may result in faster fitting as time is not wasted updating the graph to show intermediate 
results. Check Display as % Rmax if you would like your y axis displayed in this manner. Show Zero Conc Curves will 
include the subtracted blanks in the plot. The Refit options will cause the fitting algorithm to restart if it cannot get 
below the input restrictions.
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Figure 5-20: Kinetic Options: Options

Advanced Metrics: Ligand Efficiency
Ligand efficiency (LE) as a concept is a means of comparing molecules by their binding energy per atom. Therefore, 
the Octet® Discovery software will collect heavy atom count (HAC) at the protocol design stage for use in calculat-
ing ligand efficiency in Octet® SPR Analysis. The equation below defines the relationship between HAC and KD to 
estimate ligand  efficiency1 .

Figure 5-21:  Ligand Efficiency Equation 

R is the ideal gas constant, T is the analysis temperature in Kelvin, HAC is the integer value of non-hydrogen (heavy) 
atoms in the molecule and KD is the equilibrium dissociation constant.  The ligand efficiency metric can be enabled 
throughout the Octet® SPR Analysis workflow by selecting it from the Configure > Advanced Metrics menu.

1.  A.L. Hopkins, G.M. Keseru, P.D. Leeson, D.C. Rees, C.H. Reynolds. The role of ligand efficiency metrics in drug discovery. Nature Re-
views Drug Discovery. 13 (2014) p. 105-121.
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Figure 5-22: Ligand Efficiency Menu Option

Once enabled, a new LE column will appear in the Kinetics grid next to the KD column. Ligand Efficiency can also be 
displayed in Results graphs by right-clicking the graph, selecting Properties, and configuring the LE option under the 
Inset options as shown below. KD is required to be in the inset table before LE can be enabled.

Figure 5-23: Ligand Efficiency Graph
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Results Tab Introduction
The Results tab displays the plots generated during Octet® SPR Analysis analysis. Plots can be sorted by analyte or 
ligand using the respective buttons in the upper tool bar. Views of the time data or dose responses can be viewed by 
clicking the respective buttons on the lower level of the upper tool bar. The Layout drop-down menu gives the graph 
tiling options and when the visible graphs exceeds the Layout setting, the Page tab buttons allow each Page to be 
scrolled through.

Right clicking over a particular plot and clicking Properties will allow that plot to be formatted. When the plot is ready 
it can be exported as a graph, or as a raw data set (i.e. text file) by right clicking and selecting Copy graph or Copy 
data, respectively. Additionally, Configure in the file menu has the Copy visible graphs option which will copy an 
image of the current Layout view to the clipboard.

Figure 6-1: Results Page

Use the Hide button on the main toolbar to hide any undesired plots or the Filter drop-down boxes to isolate specific 
plots.

Clicking the Export button on the upper tool bar will allow the export of data in two text file formats and one image 
file format (.png). Clamp data files (.txt) include the simulation curves from model fitting if replotting in another soft-
ware is desired. Image files will be created for all the selected views. This is a simple method to produce numerous 
image files from screening data or other large data set.
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File Saving
Use the Save button on the main tool bar to save analyzed data. Saved Octet® SPR Analysis files appear as .qdt files 
and raw data files from the Octet® SPR Discovery software are exported as .qdtx files.

Figure 7-1:  Save Button

The Print pop-up (File >Print) has a variety of options  to choose from, as shown in Figure 7-2.

The Experiment tab presents a text window where one may add notes to the data set.

.

Figure 7-2:  Print Screen
Octet®  SPR Analysis User Guide



55
Appendix A:

Introduction to Non-linear 
Regression
Description of Non-linear Regression . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Initial Parameter Estimates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Assessing the Goodness of Fit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Is the Model Appropriate? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56
Octet®  SPR Analysis User Guide



Initial Parameter Estimates 56
Description of Non-linear Regression
Octet® SPR Analysis software employs non-linear regression and the Levenberg-Marquardt algorithm to fit experi-
mental data to a binding interaction model that defines the interaction. The parameters of any particular model may 
be constants or variables and may be fitted separately to each curve in a set representing various analyte concentra-
tions (i.e. local fitting) or constrained to the same value for the set of curves (global fitting). The Octet® SPR Analysis 
software fits the model to the entire data set as opposed to defining subsets of data for association and dissociation 
phases. This can be considered as a global time constraint and further improves the reliability and robustness of the 
fit. Global analysis of the data set does require very high data quality, but both Octet® SPR Discovery and Octet® 
SPR Analysis software have been optimized to achieve this.

Initial Parameter Estimates
Before fitting a model, initial parameter values must be entered that are reasonable values. Usually initial parameter 
estimates that are orders of magnitude distant from the true value do not cause any problems. When activated, the 
program iteratively changes the fitted parameters such that the average residual difference between the simulated 
curves and the experimental curves is minimized. The program stops when further reduction of the residuals 
becomes insignificant. However, it is best to choose values that are reasonable estimates as the model fitting algo-
rithm may sometimes fail to find a unique solution and get trapped in a local minimum (i.e. a false minimum that is not 
the true minimum). This is an unavoidable property of all curve fitting programs. It is also more common when fitting 
complex models with many parameters. To avoid this problem, simply observe the simulated curves before initiating 
a fit and manually iterate the initial parameter estimates until these simulated curves roughly match the actual exper-
imental data.

Assessing the Goodness of Fit
The goodness of fit is measured as the averaged residual standard deviation. Usually, if the averaged standard devia-
tion of the residuals is less than 1% of the maximum response for the curve set, this indicates an excellent fit. However, 
values that exceed 10% are sometimes acceptable (e.g. very low binding responses i.e. <20 RU). It is important to 
remember that the standard deviation of the residuals can never be lower than the standard deviation of the random 
baseline noise response for the instrument.

Is the Model Appropriate?
It is important to always consider the biological and physical relevance of any particular model to a data set. A general 
recommendation is to design the assay such that the simplest model can be used for assessment and begin fitting 
using the simplest model — a reasonable fit to this model is more likely to return good parameter estimates than 
more complex models that fit with lower residuals. For example, the two-compartment model (Transport (km, ka, kd)) 
may produce lower residuals than when the simple model is fitted, but is this appropriate for your data? If the 
observed binding rate of your interaction is relatively slow (i.e. <1e5 M-1s-1) and the Rmax is limited appropriately (i.e. 
<200 RU), then the two-compartment model is not likely required. Often experimental artifacts can give rise to com-
plex or heterogeneous binding curves which do not reflect a complexity in the interaction itself, but rather complex-
ity in the experimental design or sample condition. Fitting more complex models can be compelling when 
heterogeneous data sets require explanation, but there is danger in over-misinterpreting the data set on the basis of 
an unsupported complex model fit. It is better to design experiments where the pseudo-first-order model is a rea-
sonable approximation than to fit more complex models to your data.
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Defining the Expected Upper Limit for the Association 
Rate Constant
When fitting a model there are a number of checks one can perform to assess the consistency of the parameters that 
are returned. For example, is it reasonable if an association rate constant of 109 M-1s-1 is returned for an interac-
tion of a 100 kDa analyte with an immobilized antibody? We can answer this question by understanding the bio-
logical and physical meaning of the association rate constant.

For the vast majority of interactions, the on-rate (ka) cannot exceed a rate that is limited by molecular diffusion. This 
diffusion limitation is not related to the mass transport limitation discussed previously with reference to the two-
compartment model but to the intrinsic rate of binding. For example, increasing the viscosity will lower the ka and 
increasing the temperature will increase the ka. This is predicted from the Smoluchowski equation. The following sim-
ulation assumes:

 Temperature = 25 ºC

 Viscosity and salt = standard buffer conditions (i.e. 0.15 M salts, pH 7.4)

 Ligand has a diffusion rate of zero

 Ligand MW = 150,000 Da

 Ligand Gyration radius = 3.6 x 10-9 m

A modified Smoluchowski equation can be used to estimate the maximum possible on-rate (kmax).

Figure B-1: Modified Smoluchowski Equation

where

rab = the sum of the gyration radius for the ligand and analyte

Κ = 0.05 = interaction constant related to binding area, i.e. 25% area of A multiplied by 20% area of B thus 0.25 x 0.2 = 
0.05.

ƒ= 1 = assumes that electrostatic forces are not dominant

NA = Avogadro's number = 6.023 x 1023 mol^-1

DA , DB = Diffusion coefficient for the analyte (A) and ligand (B) respectively. If B is immobilized then DB will be zero
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Figure B-2: Plot of Smoluchowski equation

Estimated variation in kmax as a function of molecular weight under diffusion limited conditions (i.e. these represent 
the maximum possible ka values at each molecular weight). The active site area of the analyte was held constant at 
1.8 x10-18 m2.

The plot for this simulation clearly indicates that an analyte with a molecular weight of 100 kDa cannot be expected 
to produce an association rate constant of 109 M-1s-1 and an association rate constant <3 x 107 M-1s-1  is expected. 
Therefore, there must be an error in the model fit.

Interactions do exist where the maximum association rate exceeds the limit set by diffusion limitation but these are 
not common. For example, DNA-binding proteins may be electrostatically steered into the binding site by long 
range electrostatic forces1 . Thus the electrostatic factor may be in the range 1-100. This mechanism may not be 
exclusive to DNA-protein interactions but it is not dominant for most affinity ligands. There are other factors at the 
sensing surface that may influence the ka. Other spatial effects may become significant at a surface, such as the loss 
of one rotational degree of freedom, surface electrostatics, local pH and ionic strength variations at the surface, and 
the chemical aspects of immobilization. 

1.  P.H. von Hippel and O.G. Berg (1989). Facilitated target location in biological systems. J. Bio. Chem., 264 (2), 675-678.
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Description of Mass Transport
In the following discussion it will be assumed that each flow cell possesses a height, width and length of 0.003 mm, 
0.3 mm and 4 mm, respectively.

How does flow rate affect mass transport?

The mass transport limitation (MTL) factor was calculated under different flow rates keeping all other parameters 
constant to answer this question. A value of 1.0 indicates complete mass transport limitation and low values indicate 
kinetic limitation.

The SPR signal is an averaged signal over the interaction area surface. Transport of analyte to the surface is the result 
of convective and diffusion forces. These phenomena are described by the mass transfer coefficient (Lm) and are 
related to the flow cell design and operational flow rate. A good introduction to these principles can be found else-
where1 but a brief review will be provided here. The delivery of analyte in the bulk (A0) to the sensing surface (A) may 
be described by a mass transport coefficient:
  

Figure C-1: Mass Transport Coefficient

where the forward and reverse rate constants are the mass transport coefficient, km.

The interaction at the sensing surface is as follows. 

Figure C-2: Interaction at Sensing Surface

where A and B are the analyte and ligand, respectively; AB is the complex formed; and the forward (on) and reverse 
(off) rates are ka and kd, respectively.

The first reaction describes transport of the analyte to the surface and the second reaction scheme describes con-
sumption of the analyte at the surface via an affinity interaction with an immobilized ligand. In most experiments, it is 
not possible to attain 100% kinetic limitation nor is it possible to attain 100% mass transport limitation (MTL). How-

1. L. Christensen (1996). Theoretical analysis of protein concentration determination using biosensor technology under conditions of
partial mass transport limitation. Anal. Biochem., 249, 153-164.
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ever, by changing the concentration of immobilized ligand or the flow rate it is possible to control the mass transport 
characteristics. This is implied in the following relationship:

Figure C-3: Mass Transport Limitation Relationship

where:

Lr = Ka [B] = Coefficient of reaction flux

Lm = Mass transport coefficient (see expression 4)

[B] = Immobilized ligand concentration

Hence, kinetic experiments require high flow rates and low ligand concentrations, whereas high MTL conditions 
require the opposite. Most applications will require kinetic limitation, but there are some interesting applications 
requiring high MTL conditions.

When using a flow cell, it is important to minimize the height of the unstirred diffusion layer that exists at the interac-
tion surface. This can be accomplished by changing the geometry of the flow cell and the flow rate.

Figure C-4: Changing the Geometry of the Flow Cell and Flow Rate

where:

hdiff = Height of diffusion layer (m)

D = Diffusion coefficient of the analyte (m2s-1)

h, b & l = Height, width and length of flow cell (m)

F = Bulk flow rate (µL min-1)

We assume that the flow cell is 4.0 mm long, 0.3 mm wide, and 0.03 mm high, and a reasonable flow rate of 30 µl/
min. For the detection of a 50 kDa analyte, from expression (3), we estimate hdiff to be 5.5 mm. These calculations 
require the diffusion coefficient for the analyte, which may be estimated from Stokes law and the Einstein-Suther-
land equation:
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Figure C-5: Stokes Law and the Einstein-Sutherland Equation

where:

k = Boltzmann constant = 1.381 * 10-23 JK-1

T = Absolute temperature (K)

MW = Analyte molecular weight (Da)

NA = Avogadro's number = 6.022 * 1023 mol-1

η = Viscosity of liquid = 0.001 Kg/m/s

ƒ/ƒ0 = Friction factor = 1.2

The SPR signal is an averaged signal over the interaction area. Transport of analyte to the surface results from con-
vective and diffusion forces as discussed previously. These phenomena are described by the mass transfer coeffi-
cient (Lm) and are related to the flow cell design and operational flow rate by:

Figure C-6:  Mass Transfer Coefficient (Lm)

where:

 

l1 and l2 are the start and end of the active sensing region relative to the inlet position.
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What is the upper ka limit that can be estimated?

Myszka et al,1 (1999), demonstrated that the two-compartment model can resolve kinetic constants in the presence 
of 50% mass transport limitation. In general, medium to high molecular weight analytes (e.g. most proteins) will not 
have appreciable mass transport limitation. In fact, only very low molecular weight analytes will suffer mass transport 
limitation and only if capable of binding ligand at the maximum theoretical rate, which is unlikely.

1.  D. Myszka, X, He, M. Dembo, T. Morton and B. Goldstein (1998). Extending the range of rate constants available from Biacore: Inter-
preting mass transport limited data. Biophysical. J., 75, 583-594.
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Simple Kinetic Model (ka, kd)
A biomolecular interaction between a soluble analyte (A) and an immobilized ligand (B) can be interpreted in terms 
of pseudo-first-order kinetics, where the rate of formation of complex is described by the following differential equa-
tion:

Figure D-1: Simple Kinetic Model 

where:

AB(t) = Molar concentration of complex at the interaction surface at time t

A(t) = Molar concentration of analyte at the interaction surface at time t

B = Molar concentration of available immobilized ligand

ka = Association rate constant (M-1s-1)

kd = Dissociation rate constant (s-1)

Octet® SF3 instruments monitor surface interactions, and produce real-time interaction curves where the rate of 
change of response is directly related to the formation of complex AB. Equation 1 can be rewritten then in terms of 
response:

Figure D-2: Kinetic Model in Response Terms

where:

R(t) = Sensor chip response at time t

Rmax = Maximum response if all available ligand binding sites are occupied

This model holds for multi-cycle kinetics, as well as time-varying concentration injections. When employing flow cell-
based analysis, the analyte concentration at the interaction surface can be approximated by the injected analyte 
concentration at any time, assuming mass transport of analyte to the surface is not limiting.
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Figure D-3: Kinetics Model with Flow Cell-Based Analysis

where:

A0(t) = Molar concentration of injected analyte sample at time t

A(t) = Molar concentration of analyte at the interaction surface at time t

Mass Transport Limited Kinetic Model (km, ka, kd)
The analysis outlined previously describes a simple biomolecular interaction model that is governed by 1:1 pseudo-
first-order kinetic behavior. If mass transport limitation is expected to be significant then the km, ka, kd model should 
be fitted to the data set. In this model, the analyte concentration at the interaction surface is not approximated by 
the injected analyte concentration because mass transport of analyte to the surface is limiting. As a consequence, a 
second rate equation must be included to account for the analyte gradient at the sensing surface:
 

Figure D-4: Kinetic Model that Accounts for Analyte Gradient

This rate equation is integrated and coupled to equation 2, allowing the rate of formation of complex to be modeled 
when mass transport limitation is significant. This is also referred to as a two-compartment model.

Analytical Solutions for Multi-Cycle Kinetics
For multi-cycle kinetic injections, the analyte concentration from equation 2 is constant with respect to time, and an 
analytical solution exists. During the association phase, when A(t) =A0, the response at time t is given by:

Figure D-5: Fixed Concentration Model: Association Phase

where:

t0 < t < t1

t0 = Injection start time

t1 = Injection end time
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During the dissociation phase, when A(t) = 0, the response at time t is given by:

Figure D-6: Fixed Concentration Model: Disassociation Phase

where:

t > t1

R0 = Sensor response at time t1 (typically found by solving equation 5 at time t1)

Concentration Profiles for OneStep® Injections
Octet® SF3 instruments include novel injection types where the analyte concentration is not constant during the 
injection. For OneStep® injections, the concentration profile is given by the following equation:

Figure D-7: Concentration Profiles for OneStep® Injections 

where:
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Steady State Affinity Model 69
The velocity through the dispersion loop:

d = Diameter of the dispersion loop (m)

L = Length of the dispersion loop (m)

f = Flow rate (m3s-1)

D = Apparent diffusion coefficient of the analyte

r= Retention factor (0 < r < 1) (unitless)

The Diffusion model may be used to estimate the apparent diffusion coefficient by directly fitting the concentration 
profile to the SPR data when a measurement is made of the analyte’s bulk refractive index signal (no binding to 
immobilized ligand).

Steady State Affinity Model
Under steady state interaction conditions, the biosensor response varies with concentration according to the rela-
tionship:

Figure D-8: Steady State Affinity Model

where:

c = Molar concentration

Rmax = maximum response is all available ligand binding sites are occupied (in RU)

KD = Equilibrium dissociation constant (in Molar concentration)
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Bivalent Analyte Model
A bivalent analyte is one that can bind to one or two ligand molecules. Binding is expressed using two sets of rate 
constants, the first describing binding of the analyte to a first ligand molecule, and the second describing the binding 
of an analyte-ligand pair to a second ligand molecule. The binding model is governed by the following set of differen-
tial equations:

Figure D-9: Bivalent Analyte Model

where:

A(t) = Molar concentration of analyte at the interaction surface at time t

B = Available immobilized ligand

AB(t) = Concentration of complex (single analyte-ligand binding) at the interaction surface at time t

AB2(t) = Concentration of complex (analyte bound to two ligand molecules) at the interaction surface at time t

ka = Association rate constant (single analyte-ligand binding (M-1s-1))

kd = Dissociation rate constant (single analyte-ligand binding (s-1))

ka2 = Association rate constant (analyte-ligand complex binding to second ligand molecule (RU-1s-1))

kd2 = Dissociation rate constant (analyte-ligand complex binding to second ligand molecule (s-1))
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Two-State Model
This model describes the 1:1 interaction between an analyte and ligand, where the analyte-ligand complex subse-
quently undergoes a conformational change. Assumptions of this model are that the conformational change only 
occurs in the complex AB and not in the ligand alone; and that conformationally changed complex does not dissoci-
ate freely, but must undergo the reverse conformational change first. The binding model is governed by the follow-
ing set of differential equations:

Figure D-10: Two-state Model

where:

A(t) = Molar concentration of analyte at the interaction surface at time t

B = Available immobilized ligand

AB(t) = Concentration of complex (analyte-ligand binding) at the interaction surface at time t

AB2(t) = Concentration of complex (analyte-ligand in second state) at the interaction surface at time t

Ka = Association rate constant (single analyte-ligand binding (M-1s-1))

Kd = Dissociation rate constant (single analyte-ligand binding (s-1))

Ka2 = Association rate constant for formation of conformationally changed complex 

Kd2 = Dissociation rate constant for formation of conformationally changed complex 
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